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Introduction

PantonelLlVE is a cloud based architecture, and requires a license to access the digital assets
that are stored there.

Once issued a PantonelIVE license is managed through the users “Myxrite Account” and it is
necessary to match the username and password in your Myxrite account to the PantoneLIVE
license.

Part of the PantoneLIVE license mechanism requires that libraries are updated and validated at
least every 30 days.

The procedures on the following pages describe how to set up a My Xrite account, how to enter
the correct details in Col iQC and how to install and configure the iQCPantonelIVE plug in.
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Setup the “My Xrite” account
Please ensure that the Myxrite account that is going to be used has Brand Owner visibility set
to YES

Your Profile

Tell us about you:
What is our privacy policy?

Salutation
Mr v X-Rite respects and values our customers’ privacy. X-Rite will take reasonable
: steps to keep personal information collected from individual customers (such as
: name, address, occupation) secure and confidential. X-Rite will not give or sell our
First Name Last Name individual customers” personal information to any outside organization for use in
Packaging Supplier marketing, or solicitation of others” products or senices.
Title )
...See Full Policy...
Company (¥ )indicates a required field
Portal Visibility™
Address 1

Would you like to be Ysible to Brand Owners using PantoneLIVE?
Demao Street

Address 2

This ensures that the supplier can be allocated to any appropriate brand libraries.

This option can be changed at any time by going to the My Profile section of the Myxrite
account.

Suppot My X-Rite  Where to Buy

Search

*tv Downloads

My Registrations

When the order for a PantonelIVE license is placed an email will be sent to the email address
supplied on the order.

The recipient MUST follow the instructions in this mail to make the PantoneLIVE licence
accessible
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eMail - Your PantoneLIVE License mbox x & B
pantoneliveorders@xrite.com 23:28 (1 minute ago) L pantoneliveorders
o me =

pantoneliveorders @xrite.com
Dear packaging supplier, We have created one or more PantoneLIVE licenses for your order: 0. PLIVE 1 Yr Lic Color iQC (PLV-CQLVQC). Once you have i
activated a license, you will have access to the PantonelIVE Cloud =

Show detais
To claim the license(s), please proceed as follows

Using your internet browser, log in to "My X-Rite" using your Usemame and Password *
Return to this email and click on this link Your PantonelIVE license will appear **
Click on the license.

Click Edit

Check Use this activation yourself.

Click Done

Do

Kind Regards
PantonelIVE Suppan
PLsupport@xite com

The user will then need to accept the End User Licence

Ag reement You must read and accept the EULA before we can complete your license order
¥ X-Rite EULA for PantoneLIVE View EULA
licenses

Accept EULA | | Decline EULA |

The user may need to log out and back into their “My
Xrite” Account before the PantoneLIVE licence is visible.

The type of PantoneLIVE
license is shown in the My

W

IVE License

PantonelLlVE section.

P
| A8

This screen allows you to manage your icenses for PantoneLIVE. Al of your PantonsLIVE license subscriptions ae shown below. You can manage your license
subscriptions by clicking the small downward-facing arraw to expand the license diaiog. Selecting the edit ink wil allow you to managa each license and use it yourself
o1 assign 1t to someons else.

My Profile
Renewal Email Settings | Default v| |[Sae
My Downloads
+PLIVE 1 ¥r Lic Color iQC (PLV-CQLVQC) 1 Seals
My Registrations
Activation Code Assigned To Description Expires Renewal Code
Mv S'-!v_llv_\:g_"_ Caces 9647b056-55c6-4023-Bbe-66cc 2aTblech Unused 2810612015 PE4KVY adit
View EULA
My PantoneLIVE
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Installing iQCPantoneLIVE plug in for Color iQC
Go to the folder \\Program Files (x86)\X-Rite\Color_iControl\Support\ (on 32 bit PC’s this may be

C:\Program Files\X-Rite\Color_iControl\Support\)

Right click on the file iQCPantonelLIVESetup.msi and select install.

| o— R —
» Program Files (x86) » X-Rite » Color_iControl » Support
R~ A= -
MNew folder

* Mame Date modified Type : Size
E] iQCRemoteUSBClientGuide. pdf 20/08/2013 09:58 Adobe Acrobat D... 482 KB
@ dotMetFd0_Client_x86_x564.exe 09/11,/2010 09:09 Application 41,993 KB
ﬁ! IQCRemotelSB_ICAClient.exe 17/10/2013 15:55 Application 10,942 KB
ﬁ! IQCRemotelSB_ICAClientUserAccess.exe 15/10/2013 09:21 Application 596 KB
ﬁ! IQCRemotelSB_RDPClient.exe 17/10/2013 15:55 Application 11,837 KB
ﬁ! IQCRemotelSB_RDPClientUserAccess.exe 15/10/2013 09:21 Application 596 KB
|§] iControld_DBMakelndexFor ExistingDatabase.sql 03/05/2013 12:03 Microsoft SQL Ser... 22 KB
[y iControl_DBETableCreate.sql 18/09/2013 12:54 Microsoft SQL Ser... 39 KB
[y iCentrol_DBETablelUpgradeT.0.sql 18/09/2013 12:56 Microsoft SQL Ser... 6 KB
[y iCentrold_DEMakelndexFor ExistingDatabase.sql 25/10/2013 10:04 Microsoft SQL Ser... 22 KB

L [y iControld_DBTableCreate.sql 25/10/2013 10:04 Microsoft SQL Ser... 39 KB

1 [y iCentrold_DBETablelUpgrade7.0.sql 25/10/2013 10:05 Microsoft SQL Ser... 6 KB
|if375! iQCPantonellVESetup.msi 12/09/2013 13:54 Windows Installer ... 1,335 KB
A8l cnlreli e NAMSIAMI11-03 Windmae Tnetallar 2511 KR

Follow the prompts and install for “all users”.
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Activating PantoneLIVE in Col iQC

To activate the license in Col iQC.

i Open Col iQC select the option Open without job
ii. From the Settings Menu select “edit Default settings”

iii. Go to the “user settings” tab, enter the PantoneLIVE user account name in the PantonelLIVE
user name section (spellings must match the “My Xrite” account name exactly.
Change system settings |

!Systern }UWW &Submit | Tag Format |

Alternate Search Database

W)
Code Page for multibyte character conversion
Auxiliary output program
Auxiliary outputfFile
Auxiliary output label
Aux output append
Taper input filename
Taper DEroliroll position
Export 20nm 400-700 in QTX
Dispenser name size
Import comment into visual comment
Export generic CxF
Export tags with Trials.
Export tags with Standards.
Export extended measurement spectral data.
Export IFS Collections in CXF3 file.
Import tag only if defined in format file.
Enable Fized Program Tags.
Delete file from inbox after importing.
Pantonel 'VE user name

(3

PantoneLIVE user name
Enter a valid PantonelLVE account name.

iv. Press OK to accept the entry.

V. From the File menu select PantoneLIVE (or press Alt +P) this
will open up the IQC PantoneLIVE plug in dialogue.

ACP

True
.Ta pr.dat
36
False
20
|False
Falzse
True
True
[ True
False

Packaging Supplier

C ok ) ( cancel )

T

Account  Macro  Help
Ctri+N
Cirl+T
Ctri+0

Alt=P

Ed#t Nafauk a Inh Catinne

Until the license is fully activated you may see the following warning. This also shows if the username is
typed incorrectly. Press OK to dismiss the window

h This User Name doesn't match iQCPantonelIVE current credentials!
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Col iQC PantoneLIVE plug in configuration

Start Col iQC. Select “open without job”. If a job is automatically
opened then select close job (ALT+F4) so the software remains

open with no active job.

Start up the iQC PantonelIVE plug in by selecting PantonelLIVE
from the File menu or else pressing “Alt+P”. This will start up the

iQCPantoneLlVE plug in.

From the iQC PantoneLIVE edit menu, select “settings”

w Edit PantonellVE  Help
|

_I%

The following libraries are cached from PantoneLIVE™:

Library Name  Reevision

=
=
g
o

™

PREFERRED PARTNER
SunChemical

amember of the DIC group EE

toolStripServerLabel

Enter the server details
https://ws.pantonelive.com

Username = (enter your my x-rite username or the
email used to access this)

Password = (enter your myxrite account password

Set the auto update interval to an appropriate time,

we recommend 24 hours.
Press “sign in” and then “save”.

PantoneLIVE™

Server:
User Name

Password

Library Updates
Auto Update Interval:

File | Settinge Spectro Account MWacro

New e-Job Cirl+N
MNew from Template CtrlsT
Open e-Job... Ctri+0

Import from dropbox

. PantonelIVE™ Alt=P

Edit Default e-Job Settings.

Reload Selected Library
Refresh All Libraries

Delete Selected Library
Delete All Libraries

hitps://ws.pantoneLIVE com

skgpantoneliveusers @gmail.com

[sonm |

48 %] hours

d

Go to PantonellVE menu and select license activation.

T
File Edit | PantonellVE | Help
Check for Updates

The following ibr

Library Name

License Activation
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Copy or type the activation code that is displayed in your “my Xrite” account into the

e xritef = <
1| ete  Edt  Pantondve  Help

The falowing lheaies are cached fom PartonalVE™

fou can manage your icense
g each icense and use ! yourself

Settings | Diefauls

Activation Code Assigned To Description Expires Renewal Code

4023-80ka- Unusad 280672015 PEAKVY it
Yiew EULA
activation code window and press activate. A confirmation message will appear.
IM‘ !' -
o 5 by peoduct - '
T
From the PantoneLlIVE menu select “check for updates”
[ iQCPantonel IVE e -
File Edit | Pantonel |
m Check for Updates
’ License Activation [
i) From the list of PantoneLIVE libraries presented select the libraries that you require

and press Update.

The following updates are available from PantoneLIVE™. Select the updates to download and install.

Name Description Brand Owner Modified "
PANTOME+ Pastels & Neons Uncoated Mew fan deck | Pantone 09122002015
PANTOME+ Solid Coated-V2 Mew fan deck | Pantone 05/11/2014 08:1:
PANTOME+ Solid Uncoated-V2 Mew fan deck | Pantone 05/11/2014 08:2
PANTOME® F+H cotton TCX Mew fan deck | Pantone 17032014 074
PANTOME® F+H rylon brights TM Mew fan deck | Pantone 21032013 12:1.
PANTOME® FHI Color Guide Mew fan deck | Pantone 17032014 074 -
Paper Packaging Flexo Water Wht Kraft Mew fan deck | Pantone 07/05,2015 08:0 y
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i) The library should now appear in
the current library list e.g.

O, Paper Packaging Flexo Water Wht Recycled K... | 568
The process should now be complete.
For additional support/queries your contacts are

PLSupport@XRITE.com
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PantonelIVE -Regular Checking

As part of the PantonellVE licensing the iQC PantonelLlVE software needs to be activated at
least once every 30 days to ensure that the latest libraries are downloaded and that the
licensing mechanism is maintained.

If for whatever reason the “auto update function” has not been set or has been unable to run,
then the libraries will expire and their colour data obscured until the library refresh has been
completed.

If this occurs then the colour would typically appear with a red warning PL logo beside the
colour name. No accurate colour calculations can be carried out until the libraries are
refreshed.

& PSE-14C@) ; [ i
=[] Data o

r'y
~
= © rasisc chp% % -
[0 L setup1_psstac Fwce_soid () o
O] L setupi_Pastac FwcPis (@ P
[1 L setupi_pastac Fwce_so (@ e

] & setupi_pssiacrwer_as (@
[ L 1endofreel P3s14c FWCP_Solid ({8
[] L 1endofresl P3st4c FwCr_7s
[} 1 endofreel_P3si4c Fvcr_so
[} 1endofreel_pasidc Fwvce_2s
B © r2170c chp -
()

B © rzzrocFwce's

®@ee

To refresh the libraries please use the following procedure.

Enter Passwi

i) Open up Col I QC, enter the relevant password and ensure
that you select “Open without Job” m
Open Without e-Job
i) From the file menu select PantonelLIVE or ki ColeriMatch
preSS ”A|t+P" tO |aunch the File | Settings Spectro Account Macro Help
. . ] New e-Job Ctri+N
|QCPant0nELIVE p|Ug in. =] HNew from Template Cri+T
-~ Open e-Job... Ctri+0
jE Import from dropbox
| . PantoneLVE™ Alt+P

Cdit Mnfruh o dakh Cabinmn
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iii) Unless you wish download new libraries e vemesy — jm—
press Ca ncel When the new Iibra r.y Iist is The following updates are available from PantoneLIVE™. Select the updates to download and install

prese nte d Name Descrigion  Brand Owner  Modified b
1B oo st ek 3
7] Chesapeake Master Standards Newfandeck | Chesapeake 24/10/2013 020
[ Graphic Packaging Master Standards | Newfan deck | Graphic Packaging | 20/11/2013 065
[] | Graphic Packaging Offset. Recycled Board | New fan deck | Graphic Packaging | 10/02/2014 08:1
[C] | Heinz Beanz Flexo Shrink New fandeck  |Heinz 21/06/2012 16:4.
[7] | Heinz Beanz Grawure Shrink Newfandeck |Heinz 21/06/2012 16:4
[7] | Heinz Beanz Litho Carton Newfandeck |Heinz 21/05/2012 16:4
71| Heinz Beanz Litho Paper Newfandeck  |Heinz 21/05/2012 164
7] Heinz Master Standards Newfandeck  |Heinz 24/10/2013 020
[Z] | Mars Master Standards New fan deck  |Mars 24/10/2013 02:0
[C] | Mars Mottled Kraft New fandeck  |Mars 14/06/201212:4 _
2 o - S 7 |

iv) From the Edit menu in the iQCPantoneLIVE - iacrarecneive
plug in select “refresh all libraries”. B ity [ —
This refreshes all of the libraries and ensures Refrech All Librares
that items are up to date and the license
access is correct.

Library Name
& PantoneLIVE Subst
6 Munsell Measuremer
PANTOME SkinTone

Delete Selected Library
Delete All Libraries

Settings...

Z-
SLIVE |
PREFERRED PARTNER

Once this process is complete then close the plug in and resume normal operation
with Col iQC.
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